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In This Issue Keep Up with the Latest
Feature Spotlight: Microsoft Google i

Word/Excel File Tabs

Spitfire Q&A: Documents in the Plan

Room Remember that Spitfire is on Facebook, Google+ and Twitter. If you use
these social media services, you should look for us. If you LIKE us on

Facebook, include us in one of your Google+ circles and/or follow us on

Have You Read? Twitter, you’ll get our postings and announcements.

Before You Contact Support

Your Clients Area

To find us on Facebook and/or Google+, search for

Training Classes Spitfire Project Management System
Contact Us To find us on Twitter, search for sfPMS

. . You can also click the buttons on the bottom of our website.
Note: features mentioned in this

newsletter are available in V4.2.4497 | m_ +1 [ M Follow @sfPMS

Because you can open more than one Microsoft Word or Microsoft Excel file while you are working in sfPMS, tabs
appear on the dashboard for each file opened. They serve as a reminder that you have the files open. When you close a
file, the corresponding tab goes away.
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Spitfire Q&A: Documents in the Plan Room

Q: What factors affect whether or not a document appears in the Plan Room, in V4.2?

A: InsfPMS V4.2, in order for a document to appear in the Plan Room Dashboard, it must meet the following criteria:

Project Setup

Which projects are allowed to appear on the Plan Room is determined by the Plan Room Mode option on the Project
Setup’s Project tab.

(o |
Northern Lights Office Bldg -]
DOCUMENT HEADER +& .

COMMITMENT BUDGETING MODE | Update -
PLAN ROOM MODE{NIA v]

N/A
Private
FORECASTING THRESHOLD |Public

e N/A means that no documents or files for this project will appear on the Plan Room. The project itself will not
appear on the Project drop-down filter on the Plan Room.

e Private means that documents and files for the project can appear on the Plan Room (if other conditions are
met) only for those users who have role-based access to the specific project. In addition, the project itself will
appear on the Plan Room filter only for those who have access to the project.

e Public means that documents and files for the project as well as the project itself will appear on the Plan Room
for all who have access to the Plan Room.

Doc Type

Only those documents of a Doc type that has been specifically set up for the Plan Room through the Doc Types tool can
appear on the Plan Room.

DoC TYPES =
DOC TYPE LIKE: | ™~ SHOW INACTIVE DOC TYPES
D Doc Type Site Name Project Dashboard |Create From Dashboard Plan Room |Site Active |Custom
Z /8 | Ap Scans AP Scans X X X v X
2 {8 Bid gid v v X v x
V4 /B Bid Package Bid Package v v v v b4
Vd /B sid Package Addendum Bid Package Addendum | v g v v x

Doc Status

Only statuses identified through a DocStatusIsinPlanRoom rule allow documents to actually appear on the Plan Room.
Each document must have a Plan Room status in order to appear on the Plan Room.

.D Rule Group Filter Info Type |Description
3 m 2
[D-ﬁ Rule Filter Value Result Value SF
Fr E Bid Package i v
Y T Bid Package 1 v
CODE SET ]
Set Name Set Type Flag Next Set Size
= ' ' X
Doc Type Code Description Alert
Bid Package c Closed »
Bid Package E Bidding Closed x
Bid Package 1 In Process x
Bid Package a Accepting Bids x
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Before You Contact Support

Research
We pride ourselves on the quality of our support, but first, please try to resolve your problem by:

e Contacting your Spitfire Administrator to see if your in-house Spitfire experts already have the knowledge to
help you.
e Checking out the Help menu in your Spitfire application. The Help menu provides you with access to
0 The Spitfire Focus Guides
0 The Spitfire White Papers (TWPs)
0 The Spitfire Knowledge Base articles (KBAS)

These resources provide an extensive library of Spitfire knowledge that will often solve your problem if you take
the time to search through and read them.

e Looking through our new Video Training Library, which is located in the Client Area of our website. The Video
Training Library is growing every day and has hours of 2 — 10 minute videos for you to view. You need your
(or your company’s) login and password to access these videos. Contact your Spitfire Administrator for the
login and password.

Get a Quote for Custom Work

For consulting work to develop custom reports or custom work, please contact Steve Powers
(spowers@spitfiremanagement.com) for quotes on your custom work.

J

Know Your Responsibilities

Please remember that Spitfire Technical Support is here to help you with your Spitfire Project Management System, but
you do have responsibility for maintaining your software and your IT environment. Here are a few items that are your
responsibility:

e Making sure that you have a SQL Server Maintenance Plan in place to back up your database on a daily basis.
A good backup plan is well worth the effort when the unexpected happens. And don’t forget to back up your
program files.

e Making sure you have the up-to-date tax files for your location if you have an in-house Payroll system. Spitfire
is happy to help, but it is your responsibility to keep track of the tax codes that are in your system and check that
they are accurate.

e Checking that IT Updates to your computer environment (Windows updates, anti-virus programs, application
updates or upgrades, etc.) do not disrupt your Spitfire Software. Please remember that Spitfire integrates with
SQL Server, SQL Server Reporting Services, 11S, SMTP and your Exchange Server, and for some users,
Microsoft Dynamics SL, Fax software, and/or AutoVue.

e Checking that you have adequate resources, both for storage and memory, to handle your growing needs as your
data grows and you add users to your Spitfire System.

e Maintaining your workstations and understanding that Microsoft Office updates may require additional setup for
trust as Microsoft continues to add security to its products.
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Have You Read?

The following guides and white
papers have been updated for sfPMS
V4.2 since March 1.

Focus on Files, Attachments and the
Catalog Dashboard

TWP: Setup for Spitfire’s Plan Room

How to Use the Plan Room (from a

public login)

How to Use the Plan Room (from a

vendor login)

The following articles have recently
been added to the Knowledgebase:

KBA-01524 — User Save Columns in
the BFA Workbook

KBA-01525 — Division Filter on
Reports

Your Clients Area

Clients |
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The Clients area on our website includes links to our documentation, our
Knowledgebase, our forum, our downloads, and a list of what’s new in versions

4.0,4.1and 4.2

:‘SPITFI =

i
Spitfire Clients Only Area L
Clients-Only Area Lser Conference
Wevsletters Weicame to the Spitfire Clients Only ares.
Docamentation
January 2012 is now
Training
Services For all Gur past newsletter issues, 9o to the Newslatter page. Send an email to Support
Dewnloads
nowiedgebase Spitfire Project Management System V4.2
Forum Spitfire Project Management System Version 4.2 foruses on streamlined processes and system flexbity.

Amang cther changes, in sfPMS V4.2,
= Fure browser login is avadsble for users who aren't given access to the full dashboard,
= You have more control over which documents appear on the Flan Roam,
= More documents allow quickk edit on grid columns,
= Attached files can be assembied, in whatever order you want, inta & PDF for routing and printing

Version Features for 4.2

Version Features for 4.1

purposes, 0 Version Features for 4.0
= Yeu can veew @ “saapsbor” of routed ey  before and -Iwr & s routed o somecns,
- can inchude {ch tab,
= Related projects can be organied into D'W
= “Astachmert” and “[Autc) Atachment” lemnlulev replace Body Doc Templates, allowing for more
functionality,
= [hstinct Contract type and Document Sub type felds are avaisble for Project Setups and
Comemitments,
« BFA and SOV workbooks offer greaster functionality and flesibility,
System requirements for Version 4.2 are the same a3 those for Version 4.1.
e — e .

You will need your login and password to get to the Clients area. If you need
or have forgotten your login and password, contact

support@spitfiremanagement.com.

Contact Us

84 Business Park Drive, Suite 111,
Armonk, NY, 10504

Phone:888-287-4603
Fax: 888-287-4603

Support:
support@spitfiremanagement.com

Training:
training@spitfiremanagement.com

Copyright © 2012, Spitfire Management LLC.
All rights reserved

Training Classes and Videos

We offer live training classes by appointment for those who request them.
Training class descriptions are available from the Clients area of our website.

We also offer training videos from the client area of our website for those who
want to review various topics.

Training Video Library

Aside from, and corresponding with, our live training, we offer a series of training videos that can be accessed 24/7. These videos are particularly
useful for those who need to refresh their memory about a specific topic, or for new employees at companies that are already using the Spitfire
Project Management System and who need general instruction before learning the specifics at their site,

There i no limit to how many people can access or view any video at one time, nor s there a limit to how many times any video can be viewed.
Click on a header tab below to select a video in that series.

Thls series is a must for anyone who has not yet uwd or seen Ihe Spm‘lf= Project Management System (SFPMS}

+ 101A - Basic Navigation Part 1, [6:08 min]
How to log in to Spitfire, change your password and access written documentation.

+ 1018 - Basic Navigation Part 2, [2:56 min]
An introduction to the Watchdog Alerts part of the Home Dashboard.

» 101C - Basic Navigation Part 3, [6:5% min]
An introduction to the Inbox and to Spitfire documents, and how to open a document and remove it from the Inbax.

+ 101D - Basic Navigation Part 4, [9:21 min]
How to get to a Project Dashboard and create a new document. Also, an introduction to fields (look-ups, drop-downs and dates) and popEdit.

+ 101E - Basic Navigation Part 5, [5:25 min]
An introduction to the Add Files tool and how to attach files to a document. Also, how to log out.

* F - Basic Navigation P. , [7:29 min]
How to create a new Project Setup from the Home D and an

to the Addr, Dates and Items tabs.

+ 101G - Basic Navigation Part 7, [7:14 min]
An introduction to the Team Contact part of the Project Dashboard including how to add new team members to the project.

+ 101H - Basic Navigation Part 8, [7:11 min]
An introduction to the parts of the Project Dashbeard: Conditions, Remarks, Phote, KPI, Cost Analysis Details and Files.
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http://www.spitfiremanagement.com/only/clients/clientsonly_train_schedule.htm
http://www.spitfiremanagement.com/only/clients/clientsonly_train_vid_lib.htm
http://www.spitfiremanagement.com/only/clients/client_index.htm
http://www.spitfiremanagement.com/only/clients/clientsonly_docs.htm
http://www.spitfiremanagement.com/only/kb/index.php
http://www.spitfiremanagement.com/forums/index.php
http://www.spitfiremanagement.com/only/download/downloads.htm
http://www.spitfiremanagement.com/only/docs/spitfire_pm_whatsnew_4.0.pdf
http://www.spitfiremanagement.com/only/docs/spitfire_pm_whatsnew_4.1.pdf
https://clients.spitfiremanagement.com/sws/kb/docs4p2/spitfire_pm_whatsnew_4.2.pdf
mailto:support@spitfiremanagement.com
https://clients.spitfiremanagement.com/sws/kb/docs4p2/spitfire_pm_focus_files.pdf
https://clients.spitfiremanagement.com/sws/kb/docs4p2/spitfire_pm_focus_files.pdf
https://clients.spitfiremanagement.com/sws/kb/docs4p2/spitfire_plan_room_twp.pdf
https://clients.spitfiremanagement.com/sws/kb/docs4p2/spitfire_help_planroom.pdf
https://clients.spitfiremanagement.com/sws/kb/docs4p2/spitfire_help_planroom.pdf
https://clients.spitfiremanagement.com/sws/kb/docs4p2/spitfire_traindoc_planroom.pdf
https://clients.spitfiremanagement.com/sws/kb/docs4p2/spitfire_traindoc_planroom.pdf
http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=488&catId=32
http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=489&catId=21
mailto:support@spitfiremanagement.com
mailto:training@spitfiremanagement.com

